Chromebook OS Recovery

How to fix a "Something went wrong"
error on a Chromebook.
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Learning Objective

After you watch this video, you will learn to
download the USBrecovery image, recover
the Chromebook OS, erase recovery media,
and format a USB or SDcard.

Recommendations: We encourage reading through the slides
and taking notes. Areliable internet connection is required for
the OS recovery process.
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Getting started with the requirements

1. You must have a Universal Serial Bus (USB) or a Secure Digital (SD
card) with at least 8GB in order to follow this tutorial. If you use an
SD card, you will probably need an adaptor.
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Recommendation

An adaptor is
recommended if you
use an SD card




Getting started with the requirements

2. Additionally, you will need access to

another computer to download the OS to the
USB or SD card.
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Note:

Potential causes of the
: "something went wrong" error
English
@ _Englis that appears on a Chromebook
might involve:

O 1. Failed Update: An update
didn't install correctly.
Something went wrong 2. Corrupted System:
Important files or the
To try and fix this issue, start the recovery pks. Remove all connected operating System are
devices, then hold down Esc, Refresh (@), ar¥i Wwer (o)
damaged.
Hardware Problems :
There's an issue with the
(& Advanced options ») internal components like
the SSD or memory.
Low Battery: The battery is
Model:

: too low or there's a
CRET360-HXIQ Use the arrow keys to navigate up or down. . .
Use the enter key to select an option: prObIem with the Charg|ng

:t?;l)‘;j/egr:ggle.com/chromeos/recovery prOCGSS ) " .

. Connected Devices:
External devices like USBs
or peripherals might be
interfering with the
startup.

O Power off
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Google instructions on how to use the
Recovery tool

Use this tool on M55+ Chromebooks, Windows, and
Mac devices to create recovery media.
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https://bit.ly/4aG1VkK

Recommendation

Part 1: Downloading Recovery Image An adapter is

recommended if you
use an SD card

This step-by-step process will assist you
in installing the Chromebook Recovery
Utility extension and downloading the
recovery image onto a USB or SD card.

San)isk
Ultra

128cs MW
Or @ Al

° USB G SD card Adapter
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This phase requires an
“alternate computer”
to download the
Chromebook OS

recovery image.

Open a web browser;
this tutorial will use
Chrome.

However, you can use
your preferred browser
if it supports
Chromium.




S

New Tab

C

G Search Google or type a URL

Google

Search Google or type a URL

N
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Note:

Chrome extensions are
compatible with any
browser that utilizes
Chromium, the open -
source programming
language that drives the
Chrome browser.

This includes Chromium -
based browsers such as
Microsoft Edge, Brave,
Vivaldi, Opera, Epic
Privacy, and SRWare lIron.

You can get extensions
from the Chrome Web
Store or the publisher's
website. Chrome extension
support can be enabled:



O NewTab

C G Search Google or type a URL

Google

Search Google or type a URL

N
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. Open your browser.

. Click the Settings and
More button (three -
dotted) in the top -right.

. Select the Extensions
option.

. Click Manage
Extensions in the pop -
up menu.

. Turn on the Allow
extensions from other
stores toggle switch.

. Click the Allow button.



C G Search Google or type a URL

Google

Chromebook recovery utility

N

\
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Type
“Chromebook
Recovery Utility”

in the search bar.



-~
& chromebook recovery utilty- G x

C  https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA (# ¢ B & OO

Click on the
“Chromebook
Videos Shopping) | Images ) \Download ) | Windows 10 Alternative Apk Firefox Not working Aimes = | Tools  SafeSearch - Recovery Utility” .

About 5,890,000 results (0.33 seconds)

GO g]e Chromebook Recovery Utility X Q @ :

R Google .
https://chrome.google.com > chromebook-recovery-utili H ThlngS to knOW

Chromebook Reco Utility Overview
Nov 7, 2022 — This is a Chrom| lon for the Chromebook Recovery. Use this tool on Whatis Chromebook Recovery Utility?

M55+ Chromebooks, Win nd Mac devices to create recovery media...

How to open
How to open chromebook recovery utility?

People also aski How to fix

How to fix chromebook recovery utility?
How do | get to Chromebook Recovery Utility?

Create
Is Chromebook Recovery Utility no longer supported? Create Chromebook recovery USB

How do | get into my Chromebook if | forgot my password? 4 more Vv
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8
https://chrome
https://bit.ly/3R4XyJ3

v .

& Chromebook recovery utilty- G x

C  https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA (* ¢ B # O

£ chrome web store L rwsnmisonaunien v

Home > Extensions ) Chromebook Recovery Utility

Chromebook Recovery Utility Add to Chrome
KRty 730 © | Developer Tools | 1,000,000+ users k

Privacy practices Reviews Related

‘ , Click on
S “Add to Chrome”.

\ ——

IN PARTNERSHIP WITH

( Mar.'ylanders ?’(‘“ COLLEGE OF
EXTENSION & @ Onlin & NeSriuarion

UNIVERSITY OF


https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v . O

& Chromebook recovery utilty- G x

C  https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA @ ¢ & # @

£ chrome web store e Add “Chromebook Recovery Utility"? o JETRRAGI—.IT

It can
Home » Extensions » Chromebook Rec

Chromebook R

KRR 739 O | Develo

Read and change your data on dl.google.com and www.google-
analytics.com

Add extension

Privacy practices Reviews Related

- Click on
——— “add extension” .
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v .

& Chromebook recovery utilty- G x

C  https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA (# ¢ & &% O

X
m chrome web store Chromebook Recovery Utility has been added to imd.edu Vv
3
Chrome

Manage your extensions by clicking Extensions in the Tools
menu

Home » Extensions » Chromebook Recovery Utility

e Chromebook Recovery Utility

KRR 739 © | Developer Tools | 1,000,000+ users

You can now use
the Chromebook
Recovery tool
as an extension.

Privacy practices Reviews Related

‘ Create a recovery media for your Chromebook

A2 1941V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v .

& Chromebook recovery utilty- G x

C  https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA A <% B [ ]

£~ chrome web store Chromebook Recovery Utility has been
added to Chrome

Home » Extensions » Chromebook Recovery Utility

e Chromebook Recovery Utility

KR 739 © | Developer Tools| 1,000,000+ users

Manage your extensions by clicking Extensions in
the Tools menu

The Chromebook
R Recovery Utility
can be selected by
clicking on your
“extensions icon” .

*

Privacy practices Reviews Related

A2 151V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

C

Home » Extensions » Chromebook Recovery Utility

Y =

/& Chromebook recovery utilty- G x

https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA [ ¢ B % OO

Extension

£~ chrome web store

No access needed
These extensions don’t need to see
and change information on this site.

e Chromebook Recovery Utility & e B

KRR 739 © | Developer Tools | 1,000,000+ users

[e Chromebook Recovery Utility ] g

Privacy practices Reviews Related

‘ Create a recovery media for your Chromebook

\
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Click on the
“Chromebook
recovery utility”.


https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

N/
& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

C https:// Chromebook Recovery Utility w & &0

£/~ chrome web . mddigitalnavigators@umd.edu V'
Create a recovery Media for your Chromebook

Home »

You'll need 8GB or larger USB flash drive or SD card that you

e don't mind erasing. m

Click on
“Get started” .

Learn more
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

C https:// Chromebook Recovery Utility > Step 1 of 3

£~ chrome web

Identify your Chromebook

Home »

Enter the model number of the Chromebook to recover. It can be

[found on the recovery screen. ]
0 e.9. LINK DALE A-C R

1126

Select a model from a list

In this step, you will
need to find
the manufacturer
and
the product number

of your
Chromebook

AUE2 1941V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v O
& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G https:// Chromebook Recovery Utility > Step 1 of 3 f? B O

£~ chrome web mddigitainavigators@umd.edu
g

Identify your Chromebook

Home »

Enter the model number of the Chromebook to recover. It can be
found on the recovery screen.

e.g. LINK DALE A-C

1126

[Select a model from a list

Click on
“Select a model
from the list”

Learn more

AUE2 1941V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

\Qp) chromebook

In this
Chromebook
model, the
manufacturer is

Dell
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Flip your
Chromebook to
see the Product
Number; in this
S example, it’s

\ .3 3110 2in-1.
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& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G httpS:// Chromebook Recovery Utility > Step 1 of 3 Dell Chromebook 3110 2-in-1

£~ chrome web

Identify your Chromebook

Home >

Q| 5
DellChromebook 110 2:n1 > This is how it ought
Enter o o arectly to look like. After
R choosing the
"manufacturer”
and
"product,”

Dell Chromebook 3110 2-in-1

Learn more 0 back

Auig2 1511V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v .

& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G httpS:// Chromebook Recovery Utility > Step 1 of 3 Dell Chromebook 3110 2-in-1 ﬁ & O

£~ chrome web madigitalnavigators@umdedu v/
g

Identify your Chromebook

Home >

@ e

Dell Chromebook 3110 2-in-1
Dell Chromebook 3110 2-in-1

Enter a model number directly

click
continue.

Learn more Go back

Auig2 1511V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v O
& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G https:// Chromebook Recovery Utility > Step 2 of 3 Dell Chromebook 3110 2-in-1 ﬁ B O

£~ chrome web madigitalnavigators@umdedu v/
g

Insert your USB flash drive or SD card

Home

e Select the media you'd like to use
[ Select :]

\S

For this section,
you will need a
USB or SD card.

Learn more

A2 1541V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

Insert
the USB or SD

card.

IN PARTNERSHIP WITH

UNIVERSITY OF

I : I‘Z u \ Marylanders S CoLLEGE OF
EXTENSIQN ? Online @ INFORMATION



IN PARTNERSHIP WITH

UNIVERSITY OF

I : I‘Z u > Marylanders i COLLEGE OF
EXTEYNL SION ? Online @ INFORMATION



v O
& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G httpS:// Chromebook Recovery Utility > Step 2 of 3 Dell Chromebook 3110 2-in-1 ﬁ & O

£~ chrome web madigitalnavigators@umdedu v/
g

Insert your USB flash drive or SD card

ome >

e Select the media you'd like to use
PNY USB 3.2.1 FD - 461.9 GB

Select
your USB or SD
card.

Learn more

A2 151V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v O
& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G https:// Chromebook Recovery Utility > Step 2 of 3 Dell Chromebook 3110 2-in-1 ﬁ B 0O

£~ chrome web mddigitainavigators@umdeduy
Insert your USB flash drive or SD card

ome >

e Select the media you'd like to use
PNY USB3.21FD-461.9GB 5

v

[ Warning: Is this the correct media? ]

R Make sure it is the
correct USB or SD
card that you
selected.

Learn more

A2 154V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G https:// Chromebook Recovery Utility > Step 2 of 3 Dell Chromebook 3110 2-in-1 Eed ﬁ &{ * O

£~ chrome web mddigitalnavigators@umdedu v
Insert your USB flash drive or SD card

ome >

e Select the media you'd like to use
PNY USB3.21FD-461.9GB 5

v

Warning: Is this the correct media?

Click
continue .

Learn more

Make sure this is the

AUE2 1941V

correct media
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

& Chromebook recovery utiity- G
@ chromebook Recovery Utiity

G https:// Chromebook Recovery Utility > Step 3 of 3 Dell Chromebook 3110 2-in-1

£ chrome web
Create a recovery image (15786.48.0)
me )

v sz teece \ 2 On the USB or SD
card,
every partition
will be erased .
Despite this, a
recovery guide
will be provided in
this lesson.

A2 151V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

/& Chromebook recovery utility- G

C

v

@ chromebook Recovery Utiity

https:// Chromebook Recovery Utility > Step 3 of 3 Dell Chromebook 3110 2-in-1 W B O

£ chrome web

mddigitalnavigators@umd.edu

Create a recovery image (1s7ss.4s.0)

Show Advanced Settings

Important: All data and partitions on your recovery media will be deleted. om Chrome

PNY USB 3.2.1 FD - 461.9 GB

Click
continue.

Learn more Go back

A2 151V
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

& Chromebook recovery utility- G -
e Chromebook Recovery Utility

C https:/ Chromebook Recovery Utility > Step 3 of 3 Dell Chromebook 3110 2-in-1

£~ chrome web
Creating a recovery image (1s7s6.58.0)
ey

e [ Don’t remove your recovery media. ]
Downloading. 0% completed. R Th

recovery image is
now downloading ,
which could take
30 minutes or 1
hour depending
on your device.
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

/& Chromebook recovery utility- G

£~ chrome web

ome

e

e

Chromebook Recovery Utility

C https:// Chromebook Recovery Utility > Step 3 of 3

Dell Chromebook 3110 2-in-1

Creating a recovery image (1s7s6.58.0)

Don’t remove your recovery media.

Verifying download. 37% completed.

Learn more

mddigitainavigators@umd.edu

v .

w B RO

\
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It will
verify the
download
once it has

finished.


https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

/& Chromebook recovery utility- G

ne

e

e Chromebook Recovery Utility

£~ chrome web

C https:/ Chromebook Recovery Utility > Step 3 of 3 Dell Chromebook 3110 2-in-1

Creating a recovery image (1s7s6.58.0)

Don’t remove your recovery media.

Writing. 0% completed.

Learn more

v .

w B RO

mddigitainavigators@umd.edu

\
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The OS recovery is
currently being
saved
to the USB or SD
card.


https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

& Chromebook recovery utility- G -
e Chromebook Recovery Utility

C https:// Chromebook Recovery Utility > Step 3 of 3

Dell Chromebook 3110 2-in-1

£~ chrome web
Success! Your recovery media is ready (15786.58.0)
me >

e You can remove your recovery media now.

To recover your Chromebook, plug the recovery media in to your
Chromebook
After recovery, you can erase your recovery media using this utility

Learn more reate another
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Congratulations!
The OS recovery
image has been
completed. The
USB or SD card may
be ejected. Go to
files, right -click the
USB or SD card, and
click eject .


https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

v
& Chromebook recovery utility- G -
e Chromebook Recovery Utility

C https:/ Chromebook Recovery Utility > Step 3 of 3 Dell Chromebook 3110 2-in-1 w & aO

£~ chrome web mddigitalnavigators@umdedu
Success! Your recovery media is ready (15786.58.0)

e You can remove your recovery media now. m

. To recover your Chromebook, plug the recovery media in to your
Chromebook
. After recovery, you can erase your recovery media using this utility

Click
done.

Learn more Greate another
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https://www.google.com/search?q=chromebook+recovery+utility&rlz=1C1GCEA_enUS1053US1053&oq=&gs_lcrp=EgZjaHJvbWUqCQgAEEUYOxjCAzIJCAAQRRg7GMIDMgkIARBFGDsYwgMyCQgCEEUYOxjCAzIJCAMQRRg7GMIDMgkIBBBFGDsYwgMyCQgFEEUYOxjCAzIJCAYQRRg7GMIDMgkIBxBFGDsYwgPSAQkxMDYxajBqMTWoAgiwAgE&sourceid=chrome&ie=UTF-8

This sequential procedure will guide you in restoring the
Chromebook operating system using the USB or SD card
with the recovery image.

San)isk
Ultra

128ce Mz
S @ A1

USB SD card
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Recommendation

An adapter is
recommended if you
use an SD card




Eject
the USB or SD
card
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@ English

Something went wrong

To try and fix this issue, start the recovery process. Remove all connected
devices, then hold down Esc, Refresh (e), and Power (o)

w

[@ Advanced options b]

O Power off

Model:

CRET360-HXIQ Use the arrow keys to navigate up or down.

Use the enter key to select an option:

Help center:
https://google.com/chromeos/recovery
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Unfold
the Chromebook
that requires the
recovery
operating system.




Insert
the USB or SD
card with the
recovery image.

IN PARTNERSHIP WITH

UNIVERSITY OF

I : h u \ Marylanders S CoLLEGE OF
EXTENSIQN ? Online @ INFORMATION



IN PARTNERSHIP WITH

UNIVERSITY OF

lﬂ JD > Marylanders St COLLEGE OF
E XTEYNL STON © oniive & RESrion



Once you plug in
the USB or SD
card with the

recovery image,

press and hold
‘Escape’ key.
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Keep holding the
previous button.

Press and hold,
Refresh key
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Keep holding the
previous buttons.

Press and hold
the power on and
off button.

Simultaneously
release the buttons to

initiate the recovery
process.
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@ English
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External disk with recovery image detected

This process may take a few minutes

UNIVERSITY OF

EXTENSION

—NK

Model:

CRET360-HXIQ .
Use the arrow keys to navigate up or down.
Use the enter key to select an option:

Help center:

https://google.com/chromeos/recov

ery
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Wait
for the operating
system to finish
recovering. It can
take ten minutes or
longer to complete
this operation.




@ English

©)

©O—@

System recovery is in progress

This will take a few minutes. Please do not turn off the computer or disconnect the power.

UNIVERSITY OF

EXTENSION

w

Model:

CRET360-HXIQ .
Use the arrow keys to navigate up or down.
Use the enter key to select an option:

Help center:

https://google.com/chromeos/recov

ery
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During this process,
do not disconnect
the USB / SD card

or turn off the
Chromebook.




@ English
©—0O—0O

Recovery is now complete

Unplug your external disk to restart.

w Congratulations!
the recovery is

now completed .

Model:

CRET360-HXIQ .
Use the arrow keys to navigate up or down.
Use the enter key to select an option:

Help center:

https://google.com/chromeos/recov

ery
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Remove
the USB or SD

card now.
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Wait
for the
Chromebook to
turn on.

& chromeOS
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@chromeOS
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\

Welcome to your Chromebook

Fast. Secure. Effortless

UNIVERSITY OF
é Marylanders
EXTENSION = = Onlin
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Note:

An update will
appear on the
screen:; it will take
around seventeen
minutes or longer
to complete.

Your Chromebook

OS is now restored.

Setting it up would
be the next step.

The next tutorial
will guide you on
how to erase
recovery media.



This step-by-step process will instruct you
on how to remove the recovery image
from the USB or SD card that was
previously utilized to restore the
Chromebook operating system.

San)disk
Ultra

Or 1288 M3 W
@© Al

USB SD card
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Recommendation

An adapter is
recommended if you
use an SD card




Open a web
browser ;
this tutorial will

use Chrome.
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New Tab

C

~
c

X

Search Google or type a URL

Google

Q. Search Google or type a URL

\

Aug 2

124V &
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EXTENSION
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Click on
“Extensions”



O NewTab x

C G Search Google or type a URL

Extension

No access needed
These extensions don’t need to see
and change information on this site.

Application Launcher for Drive ... g

Googlec==

Click on
Q_  Search Google or type a URL : “ChromebOOK
Recovery Utility” .

\ ——
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O NewTab X
@ chromebook Recovery Utiity

Se: Chromebook Recovery Utility

Create a recovery Media for your Chromebook

You'll need 8GB or larger USB flash drive or SD card that you
don’t mind erasing.

Learn more

\

Aug 2
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Click on
“Settings” .



O NewTab X
@ chromebook Recovery Utiity

Se: Chromebook Recovery Utility

Create a recovery Media for your Chromebook Use local Image
Send feedback

You'll need 8GB or larger USB flash drive or SD card that you
don’t mind erasing.

Click on
“Erase recovery
media” .

Learn more

Ag2 15V W
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O NewTab

X
@ chromebook Recovery Utiity

G = Sei Chromebook Recovery Utility

Erase recovery media

[Select the media you'd like to use ]

W

\
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In this step,
you will need the
USB or SD card
that was

previously utilized

to restore the

Chromebook
Operating System.



Insert
the USB drive or
SD card
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X
@ chromebook Recovery Utiity

G = Sei Chromebook Recovery Utility

Erase recovery media

Select the media you'd like to use

[ Select

\S

\
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Click on the
“Select”
option and
choose the USB
device.



O NewTab X
@ chromebook Recovery Utiity

Click on
Continue.

Sei Chromebook Recovery Utility

Erase recovery media

Select the media you'd like to use

USB Drive - 14.6 GB

Learn more
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O NewTab X
@ chromebook Recovery Utiity

Sei Chromebook Recovery Utility

Erase recovery media The recovery
image
USB Drive - 14.6 GB R Wi" be erased .

[The recovery image and all partitions on your recovery media will be erased ]

Learn more

Ag2 15V W
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O NewTab X
@ chromebook Recovery Utiity

Sei Chromebook Recovery Utility

Erase recovery media

The recovery image and all partitions on your recovery media will be erased

USB Drive - 14.6 GB

Learn more

\

Aug 2
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Click on
Continue.



O NewTab X
@ chromebook Recovery Utiity

Sei Chromebook Recovery Utility

Your recovery media has been erased.

Your USB drive or SD card is prepared for formatting.
Format using a formatting tool provided by your operating system.

IS

Learn more

\

Aug 2
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Congratulations!
Your recovery
media has been
erased.



X
@ chromebook Recovery Utiity

Sei Chromebook Recovery Utility

Your recovery media has been erased.

Your USB drive or SD card is prepared for formatting.
Format using a formatting tool provided by your operating system.

R

\
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The USB has been
successfully
restored.

Click on
“Done”.

The next tutorial
will guide you on
how to format the
USB for it to work

properly.



Recommendation

Part 4 : Formating USB or SD card An adapter is

recommended if you
use an SD card

This step-by-step process will instruct you on
how to format the USB or SD card that was
previously utilized to restore the

Chromebook operating system.

San)disk
Ultra

12868 MU
Or @ A

° USB e SD card Adapter
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Click on
“Files”.
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Drive

| —

& Downloads <

@ Recent My files

Name
v 1 Myfiles

4, Downloads

Google
» 3 g

Date modified 4

Today 10:45
AM

You'll need the
USB or SD card
drive that was
successfully
restored for this
part.
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Insert
the USB or SD
card.
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@ Recent

v O Myfiles
& Downloads

N Google
% '. Drive

¢ USBDrive

\

USB Drive

[ﬁb This device cannot be opened because it's filesystem was not recognized.

Format device ]

\S

This prompt will
appear.
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@ Recent

v [ My files

& Downloads

N Google
> '. Drive

¢ USBDrive

\

USB Drive

th This device cannot be opened because it’s filesystem was not recognized.

If this is the case,
all you need to do
is click on
"Format device“.
If not, move on to
the next slide.
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® Recent

& Downloads

5 '\ Google

Drive

¢ USBDrive

S

| —

USB Drive

Name
v 1 Myfiles

4

Date modified 4
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Right-click
"USB Drive*




) o

Select
"Format Device."

® Recent USB Drive

Name
v [ My files i Date modified 4

& Downloads

< " Google

Drive

¢ USBDrive

Eject device Ctrl+Shift+R

Format device

Renam% Ctri+Enter

\ ——

IN PARTNERSHIP WITH

( Marylandel"s @ COLLEGE OF
Onlin §. INFORMATION

UNIVERSITY OF

EXTENSION

TRyLR®



) O

@  Recent USB Drive c Give the USB or SD
card a name, and
select the format
Format USB Drive Option if Oﬁered.

> " Google Formatting a drive will delete all data stored on it. This action
-y

v O My files #h  This device cannot be opened because it's filesystem was not recognized.

& Downloads

Drive cannot be undone.

Drive Name

¢ USBDrive
Format R

FAT32

aaaaa

k —— 1 —. J
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@ Recent

v [ My files

& Downloads

Google
» 3 4

Drive

¢ USBDrive

\

USB Drive

th This device cannot be opened because it’s filesystem was not recognized.

Format USB Drive

Formatting a drive will delete all data stored on it. This action
cannot be undone.

Drive Name

OS-R

Format

FAT32

[ FAT32

exFAT \3
NTFS

Note:

FAT32s an outdated

file system that isn't as
good as NTFS exFATis a
newer alternative to
FAT32 and is supported
by more devices and
operating systems than
NTFS, though it's not as
common as FAT32. NTFS
is the most current file
system. Windows
typically uses NTFS for
its system drive and
most other drives that
aren't removable.
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Drive

\

@ Recent

v [ My files

Google
» 3 4

& Downloads

¢ USBDrive

USB Drive

This device cannot be opened because it’s filesystem was not recognized.

Format USB Drive

Formatting a drive will delete all data stored on it. This action

cannot be undone.
Drive Name

OS-R

CCCCCC

After you've
chosen the name
of your USB / SD

card and
the type of
format you want,
Click on
“Erase and
Format” .
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® Recent USB Drive

Name
v [ My files

& Downloads

N Google
> ' Drive

\

| Size

Type

Date modified

Congratulations!
You can now use
the USB or SD
card drive in the
same way as
before the OS
recovery.
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MARYLANDERS ONLINE CALL CENTER

e Marylanders Online is an initiative through the University of Maryland Extension (UME) and College
of Information Studies (INFO) with state funding that aims to bridge the digital divide throughout
the state of Maryland.

e Marylanders Online Call center is here to provide FREE one-on-one tech support to all the Maryland
residents and bring digital equity in Maryland.

e It provides: Let's connect!
o Tech support in English and Spanish
o Device support including hardware and Monday to Friday: 10:00 am to 8:00 pm
software Saturday: 10:00 am to 5:00 pm
O Assistance in getting connected with internet Number: 301-405-9810

o ACP application assistance Toll Free: 1-866-206-8467

o Connect to local organizations offering various

Email: marylandersonline@umd.edu
Website: marylandersonline.umd.edu

digital skills classes, device program, and much
more.
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Thanks for watching!

UNIVERSITY OF

EXTENSION

Marylanders
Online

IN PARTNERSHIP WITH
sk,
= 1 COLLEGE OF

Bt INFORMATION

%

USDA
S United States Department of Ag
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n accordance with Federal law and U.S. Department of
Agriculture (USDA] civil rights. regulations and policies, this
insttution s prohited from discriminating on the basts of race,

calor, national origin, sex (including gender identity and sexual

orientation). age. disability. and reprisal or retakation for prior vl

rights activity

Program nformation may be made avallable in languages other
than English. Persons with disabllties who require aiternative
means of communication for program informaton (e.g.. Braile.
large print, audiotape, and American Sign Language) should
contast the respansibi St ar acal Agency thal adminsters he
program or USDA's TARGET Center at (202) 7:

onforme s Ia ley federal y les politicas y regulaciones de

jerechos civiles del Departamento de Agricultura de los

Estaddos Unidos (USDA), esta instiucicn tene prohibide
discininar por motlvos de aza, color, origen nacianal, sexo finckyendo

identidad de generc y orientacion de sexual), sdad, discapacidad venganza

Grepresalia por actividades reaizadas en el pasado relacian
con los derechos civies.

La informac puede astar

idiomas ademas del inglés. Las persanas con discapacidsdes que
reguieran medios de comunicacién sitemativos para oblener
infermacién scbre el pragrams (por ejempio, Braibe, letra
agrandada, grabacion de audio y lenguaje de sefias americano)

TTY) or contact USDA through the Federal Relay Senvice at
(800) 877-8339.

Tofiea nation compiaint, & should
complete a Form AD-3027. USDA Program Disarimination
Complaint Form, which can be obtained onfine, at
hitps./iwww.usda.gow/sites/default/files/documents/ad-3027.pdf.

from any USDA office, by caling (366) 632-9982, or by writing a
letter addressed to USDA_ The letter must contain the
complainant's name, address, telephone number, and a written
description of the alleged discriminatory action in sufficient detall
ta inform the Assistant Secretary for Civil Rights (ASCR) about
the nature and date of an alleged civl rights viclation. The
completed AD-3027 form or letter must be submitted to USDA by:

mail:

U.S. Department of Agriculture

Office of the Assistant Secretary for Civil Rights
1400 Independence Avenve, SW

Washingtan, D.C. 20250-8410; or

fax:

(833) 256-1865 or (202) 690-7442; or

email:

pregram.intake@usda.gov.

This institution fs an equal opportunity provider.

deben can la agencia estatal
simiiara s programs o can =l TARGET Canter 3| USDA ol (202)
7202600 {voz y TTY) o comunicarse con ol USDA & ravés del
Sanvcia Federal de Transmisidn de Informacisn sl (800) B77-8339,

Para presentar una qusja par discriminacién en & programa, &l
reciamante debe completar un formulsnie AD-3027, Formulario de
queja por discriminacion del programa del USDA, que se puede
obtener en linea. en htps:imvy usda govistesidefautifles!

/8l al il lwr ofici 1| llamando
al (856 6320992, o escribiencic una canta dirigida al USDA. La
carta dabe contana el nombre, la dreccién y ol nimero de teléfonc
del reciemants, y una descripcidn ascrita de la supueste accidn
discriminatona con suficiente detalle para informar al Subsecretario
de Darechos Civles (ASCR, por sus sigias en inglés) sobre
natwaleza y la fecha de la presunta violacion de los derachos
civiles. La carta o el formulano AD-3027 completado debe enviarse
al USDA por madsa de
correo postal:

US. Depanment of Agriculturs

Offics ofthe Assistant Secretary for Civil Rights
1400 Independence Avenue, SW

Vigshington, .G, 20260-8410;0°

fax:
(833) 256-1685 0" (202) 690-7442;0°
correo electranico:

ram in)

Esta insttucidn ofreca gualdsd de oponunidades.
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